
March 2017   |   9.0.0 7720 and 8172 

 

 

 

 

 

 

 

 

 

 

WORKSHARE 9 
CONFIGURATION OPTIONS 



 

2 

Workshare 9 Configuration Options 

Table of Contents 
Workshare Configuration Parameters ........................................................................ 3 

Protection>Administration ....................................................................................... 4 

Protection>Sharing ................................................................................................. 9 

Protection>Interactive Protect ............................................................................... 11 

Protection>Remove Metadata .............................................................................. 21 

Protection>Exclude Metadata ............................................................................... 38 

Protection>Convert to PDF ................................................................................... 43 

Protection>Compress as Zip ................................................................................. 45 

Comparison>Administration .................................................................................. 46 

Comparison>User Interface .................................................................................. 51 

Comparison>Rendering Sets ................................................................................ 53 

General>Administration ........................................................................................ 56 

General>User Interface ........................................................................................ 58 

Integrations>General ............................................................................................ 59 

Integrations>iManage ........................................................................................... 62 

Integrations>Microsoft SharePoint ........................................................................ 64 

Registry Configuration .............................................................................................. 66 

Convert Hyperlinks ............................................................................................... 66 

Small Text Removal .............................................................................................. 67 

 

 

 



 

3 

Workshare 9 Configuration Options 

Workshare Configuration Parameters 
The configuration parameters for Workshare Professional, Workshare Compare and 
Workshare Protect are in the Workshare Configuration Manager. They are grouped into 
categories and sub-categories as follows:  

Category Sub-Category Page 
Protection Administration 4 

 Sharing 9 

 Interactive Protect 11 

 Remove Metadata 21 

 Exclude Metadata 38 

 Convert to PDF 43 

 Compress as Zip 44 

Comparison Administration 46 

 User Interface 51 

 Rendering Sets 53 

General Administration 56 

 User Interface 58 

Integrations General 59 

 iManage 62 

 Microsoft SharePoint 64 

Click a sub-category to display the parameters for that sub-category. The different sub-
categories and their parameters are described in the following sections. 
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Protection>Administration 
The Protection > Administration parameters enable you to specify how Workshare 
Protect functions in specific situations. 

 
The Protection > Administration parameters are described in the following table: 

Parameter Description Default 
Apply 
Workshare 
Protect 

If selected, Workshare Protect will check emails and 
their attachments to see if they breach any security 
policies. 

Internal: 
Not 
selected 
External: 
Selected 

Detect 
Workshare 
styles 

If selected, Workshare Protect will check emails and 
their attachments to see if they include any Workshare 
styles. Workshare styles are applied to changes in a 
Redline document. 

Internal: 
Not 
selected 
External: 
Not 
selected 
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Parameter Description Default 
Allow users 
to change 
metadata 
removal 
options 

Administrator Mode only. 
If selected, the Remove Comments and the Remove 
Track Changes checkboxes as well as the Office 
Metadata and PDF Metadata tabs are available in the 
Advanced Email Security Options dialog. These options 
enable the user to specify exactly which hidden data 
types to remove from an attachment. 
This parameter has no effect on the Protect Profile 
dialog. 

Selected 

Allow users 
to change 
PDF options 

Administrator Mode only. 
If selected, the Convert to PDF checkbox as well as 
the Convert to PDF tab are available in the Advanced 
Email Security Options dialog. These options enable 
the user to specify whether or not to convert an 
attachment to PDF and what, if any, PDF security 
settings to apply. 
This parameter has no effect on the Protect Profile 
dialog. 

Selected 

Allow users 
to skip 
metadata 
removal 

Administrator Mode only. 
If selected, the Skip Cleaning checkbox is enabled in 
the Advanced Email Security Options dialog, the Send 
without processing option is available in the Protect 
Profile dialog and the Remove metadata checkbox is 
enabled in the Interactive Protect panel. In the 
Advanced Email Security Options dialog and the 
Interactive Protect panel, this option enables the user to 
omit all metadata cleaning. In the Protect Profile dialog, 
this option enables the user to skip all processing, for 
example, all metadata cleaning and PDF conversion. 

Selected 

Content risk 
runtime 
policy path 
(this 
overrides the 
default path) 

Administrator Mode only. 
If specified, Workshare will use this policy when 
discovering content risk in open Office documents. This 
is relevant when the default policy is not used and 
customized policies have been created using the 
Workshare Policy Designer. 

Note: If you use a personalized company profile and 
you do not want the default profile to exist as well, 
you should also deselect the Enable automatic 
generation of default profile parameter. 
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Parameter Description Default 
Display 
Advanced 
Options 

If selected, the Advanced Options link is enabled in 
the Protect Profile dialog providing access to the 
Advanced Email Security Options dialog. 

Selected 

Display 
progress bar 
on Send 

If selected, a progress bar appears when cleaning and 
sending an email. 

Selected 

Display Send 
with Protect 
button 
(Outlook) 

If selected, a Send and Protect button is displayed in 
email messages. Clicking this button enables the user 
to always access the Advanced Email Security Options 
dialog (regardless of policy settings) and specify 
cleaning or converting to PDF of attachments as 
required. 

Not 
selected 

Enable 
automatic 
generation of 
default 
profile 

If selected, the default profile is regenerated when a 
value is changed in the Registry for an option in the 
Protection category. This change may be as a result of 
a manual change made in the Registry or by changing 
and applying a parameter value in the Protection 
category of the Workshare Configuration Manager. 
Additionally, the default profile is also regenerated 
when the Workshare Configuration Assistant is run. 
You may want to deselect this parameter if you want to 
deploy a personalized company profile and you do not 
want the default profile to exist as well. 

Selected 

Enable 
Lightspeed 
Clean 

If selected, when an email or its attachment triggers a 
Clean action, Workshare Protect will perform a 
Lightspeed clean. This type of cleaning is faster than a 
regular clean. 

Not 
selected 

Enable 
Secure File 
Transfer 
when 
sending 
emails 

If selected, the Secure File Transfer profiles are 
available in the Protect Profile dialog and users can 
securely send files by replacing attachments with a link 
to the documents in Workshare online. 

Selected 

Internal 
Domain List 
(Lotus Notes) 

In multi-domain Lotus Notes environments, specify the 
domain names of all internal servers to ensure that 
internal/external resolution works correctly. Separate 
each domain name with a semicolon. 

 

Proxy 
address 

The URL of an Internet proxy server (if used).  

Proxy 
password 

The password to access an Internet proxy server (if 
used). 
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Parameter Description Default 
Proxy port The port of an Internet proxy server (if used).  

Proxy 
username 

The user name to access an Internet proxy server (if 
used). 

 

Server 
Profile 
Distribution 
List 

The name of the distribution list on the Microsoft 
Exchange Server that is used to return the correct 
Workshare Protect Server profile email addresses. This 
is only relevant when selecting Protect Profile dialog 
using server profiles as the value for the When 
sending an email with attachments show parameter.  

ProtectSer
ver_Profil
es 

Show Default 
profile in 
Protect 
Profile dialog 

If selected, the Default profile is available in the Protect 
Profile dialog. 

Selected 

Treat 
footnotes as 
metadata 

If selected, footnotes are also treated as hidden data. 
You will be able to see details of the footnotes in a 
document in the content risk report. 

Not 
selected 

Treat the 
specified 
addresses as 
internal 
(Outlook) 

You can specify any email addresses/distribution 
lists/domains here that you would like to be treated as 
internal for the purpose of Workshare Protect applying 
policies. Separate multiple addresses with a semi-
colon. For example, john@yahoo.com; 
*@hotmail.com will mean that emails to john’s 
individual yahoo email address are treated as internal 
as well as emails to any hotmail addresses. 

 

Use proxy 
server 

If selected, a proxy server (as specified in the 
parameters above) is used for connecting to the 
Internet. 

Not 
selected 

When 
sending an 
email with 
attachments 
show 

Shows the required behavior when Workshare Protect 
is enabled. Options are: 
• Interactive Protect: The Interactive Protect panel is 

displayed in the email message window as soon as 
attachments are added providing options to clean 
attachments, convert them to PDF and compress 
them as well as securely transfer the attachments to 
Workshare online. 

Note: The Interactive Panel is displayed for all emails 
with attachments regardless of your selection for the 
Apply Workshare Protect parameter. 

Interactive 
Protect 

mailto:john@yahoo.com
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Parameter Description Default 
• Protect Profile dialog using desktop profiles: The 

Protect Profile dialog is displayed after clicking 
Send. It provides a list of profiles available locally. 

• Protect Profile dialog using server profiles: The 
Protect Profile dialog is displayed after clicking 
Send. It provides a list of profiles available on 
Workshare Protect. 

• Email security dialog while discovering risk: The 
Advanced Email Security Options dialog is always 
displayed. It is displayed immediately after clicking 
Send while Workshare Protect checks the email 
against the default profile. The options are enabled 
once the check is complete. 

• Email security dialog for all mail: The Advanced 
Email Security Options dialog is always displayed. It 
is displayed after clicking Send once Workshare 
Protect has checked the email against the default 
profile. 

• Email security dialog for internal mail only: The 
Advanced Email Security Options dialog is displayed 
when an email has internal recipients. It is displayed 
after clicking Send once Workshare Protect has 
checked the email against the default profile. For 
email to external recipients only, the Advanced 
Email Security Options dialog is not displayed. This 
is only relevant when Apply Workshare Protect is 
selected for Internal Email. 

• Email security dialog for external mail only: The 
Advanced Email Security Options dialog is displayed 
when an email has external recipients. It is displayed 
after clicking Send once Workshare Protect has 
checked the email against the default profile. For 
email to internal recipients only, the Advanced Email 
Security Options dialog is not displayed. This is only 
relevant when Apply Workshare Protect is 
selected for External Email. 

• No dialog (process actions transparently): The 
Advanced Email Security Options dialog is not 
displayed. Workshare Protect processes the email 
and applies the default profile without any user 
intervention. 
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Protection>Sharing 
The Protection > Sharing parameters enable you to configure how Workshare Protect 
uploads attachments to Workshare online. 

 
The Protection > Sharing parameters are described in the following table: 

Parameter Description Default 
Automatically 
convert to link(s) 
when total 
attachment size 
exceeds (MB) 

When attachments exceed the size specified then 
they will automatically be converted to links. This 
means the attachments will be saved to a folder in 
Workshare and recipients receive a link to that 
folder. The user will see the link in the body of 
their email. They can still select to 
clean/convert/compress the attachment. Only 
when they click Send will the link be sent to the 
recipient. 

Note: This option works as described regardless 
as to how Protect is configured. 

 

Display Attach as 
Link button 
(Outlook) 

If selected, the Attach as Link button is displayed 
in email messages. Clicking this button enables 
the user to use the sharing functionality to send a 
link to a large file when it cannot be sent by email. 
(Your administrator may set a limit on the size of 
files you can email to avoid large files blocking 
Exchange.) 

Selected 
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Parameter Description Default 
Display Link on 
attachments bar 

If selected, users can always click Link on their 
attachments bar to convert their attachments to 
links. The attachments will be saved to a folder in 
Workshare and recipients will receive a link to that 
folder. The user can still select to 
clean/convert/compress the attachment. Only 
when they click Send will the link be sent to the 
recipient. 

Note: This option works as described regardless 
as to how Protect is configured. 

Not 
selected 

Display Manage 
Permissions on 
attachments bar 

If selected, when attachments have been 
converted to links, a Manage Permissions option 
is displayed on the attachments bar. Clicking this 
option enables the user to set access permissions 
to the attachment(s) in Workshare. For example, 
you could set an expiry date so the files are only 
available for a limited time. 

Selected 

Enable 
Workshare 
Connect – real 
time collaboration 

If selected, the save and share to Workshare 
online options (Sharing group) are available in the 
Workshare tab in Office. 

Selected 

Ignore these Bcc 
addresses 

When attachments are uploaded to Workshare 
online, ALL recipients (including Bcc recipients) 
receive an email with a link to the attachments. 
Bcc recipients therefore do not remain hidden from 
other recipients. 
If no email addresses are specified for this 
parameter, when an email includes a Bcc address, 
Workshare prompts the sender to remove the Bcc 
address, as it will not remain hidden. 
If email addresses are specified here, when they 
appear in the Bcc field, Workshare will not prompt 
but will treat the email addresses as ordinary 
recipients. 
Separate multiple addresses with a semi-colon. 
For example, john@yahoo.com; *@hotmail.com 
will mean that when john’s individual yahoo email 
address or any hotmail addresses appear in the 
Bcc field, Workshare will not prompt the sender to 
remove the Bcc address but will treat the email 
addresses as ordinary recipients. 

 

mailto:john@yahoo.com
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Parameter Description Default 
Retain 
attachments in 
Sent Item 

If selected, when an email with a link to an 
attachment in Workshare online is sent, the email 
saved in the senders Sent folder includes the 
actual document attachment. 

Not 
selected 

Share email body 
prefix 

The text included in the body of the email sent 
when sharing an attachment from Interactive 
Protect. 

I’ve 
shared a 
file with 
you: 

Share email body 
prefix (multiple 
files) 

The text included in the body of the email sent 
when sharing multiple attachments from 
Interactive Protect. 

I’ve 
shared 
files with 
you: 

SSO Domain 
Name 

The domain name used for single sign on to 
Workshare. 

 

Workshare user 
login email 

User Mode only. 
The email address used for the login to your 
Workshare account. 

 

Protection>Interactive Protect 
The Protection > Interactive Protect parameters enable you to configure how the 
Interactive Protect panel will appear to users. 

The parameters in the top half enable you to specify what metadata should be visible in 
the Interactive Protect panel and what metadata is cleaned by default. 

The parameters in the lower half enable you to specify whether users will be able to 
access and modify settings in the Interactive Protect panel. 

Tip! You can select all parameters in a column by selecting the checkbox in the 
column header and then deselect one or two metadata parameters within that column 
as required. 
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The Protection > Interactive Protect parameters are described in the following table: 

Parameter Description Default 
Accept 
changes and 
turn off Track 
Changes 
(Word and 
Excel) 

Microsoft Word and Excel. If selected, accepts all 
revisions made to the document. The revisions are 
therefore no longer displayed as revisions but rather 
as text in the document. Track changes is also turned 
off so that further revisions are not tracked. 

Visible, No 
clean 

Convert 
attached 
template to 
Normal 
(Word) 

Microsoft Word only. If selected, converts the attached 
template to normal.dot. Automatic style updating is 
disabled before the template is removed. Therefore 
the formatting and styles in your document will not be 
affected by removing the attached template. 
To view the attached template: Click the File 
menu/Office Button, select Options/Word Options 
and then select Add-Ins. From the Manage dropdown 
list, select Word Add-ins and click Go. 

Visible, 
Clean 
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Parameter Description Default 
Convert field 
codes to text 
(Office) 

Microsoft Word, Excel and PowerPoint. If selected, 
converts any field codes that exist in a Microsoft Word 
document to text, for example, hyperlinks, table of 
contents, index. In Microsoft Excel and PowerPoint, 
hyperlinks are converted to text. 

Note: For Microsoft Excel and PowerPoint, 
hyperlinks are the only field codes that exist. 

This prevents the field codes from being updated after 
you have distributed the document. It also prevents 
errors for fields that reference built-in or custom 
properties that have been removed. 

Note: You can prevent certain field codes from 
being cleaned, for example, table of contents or 
page numbers, by selecting them in the Protection 
> Exclude Metadata category. Refer to page 38. 

To view field codes: Click the File menu/Office Button, 
select Options/Word Options and then select 
Advanced. Select the Show field codes instead of 
their values checkbox in the Show document 
content area. 

Visible, 
Clean 

Delete 
attachments 
(PDF) 

PDF. If selected, removes any attachments to a PDF 
file. 

PDF attachments are separate files attached to a PDF 
file generally or linked to a specific point in a PDF file. 
Selecting this option will only remove the first type of 
attachment. Attachments linked to a specific point in a 
PDF file are treated as markups and will only be 
removed if the Delete markups parameter is selected. 

Visible, 
Clean 

Delete 
bookmarks 
(PDF) 

PDF. If selected, removes any bookmarks in a PDF 
file. 

Visible, 
Clean 
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Parameter Description Default 
Delete built-
in properties 
(Office) 

Microsoft Word, Excel and PowerPoint. If selected, 
removes all summary properties - author, category, 
comments, company, keywords, manager, title, 
subject, and hyperlink base; and custom properties – 
text, date and number. 
To view built-in properties: In MS Office 2010/2013, 
click the File menu, select Info and then select 
Advanced Properties from the Properties dropdown 
list in the right panel. In the Properties dialog, select 
the Summary and Contents tabs. In MS Office 2007, 
click the Office Button, select Prepare and then select 
Properties. In the Document Information Panel, select 
Advanced Properties from the Document 
Properties dropdown list. In the Properties dialog, 
select the Summary and Contents tabs. 

Visible, 
Clean 

Delete 
comments 
(Office) 

Microsoft Word, Excel and PowerPoint. If selected, 
removes any comments embedded in the document. 
By default this parameter is not selected. 
To display comments: In MS Office 2010/2013, click 
the Review tab and from the Show Markup dropdown 
list (Tracking group), select Balloons then Show 
Only Comments and Formatting in Balloons. In MS 
Office 2007, click the Review tab and from the 
Balloons dropdown list (Tracking group), select 
Show Only Comments and Formatting in Balloons. 

Visible, No 
clean 

Delete 
custom 
properties 
(Office) 

Microsoft Word, Excel and PowerPoint. If selected, 
removes any custom properties that have been added 
to the document. 

Note: You can prevent certain custom properties 
from being cleaned, for example, DMS Doc ID 
Properties, by selecting them in the Protection > 
Exclude Metadata category. Refer to page 38. 

To view document properties: In MS Office 2010/2013, 
click the File menu, select Info and then select 
Advanced Properties from the Properties dropdown 
list in the right panel. In the Properties dialog, select 
the Custom tab. In MS Office 2007, click the Office 
Button, select Prepare and then select Properties. In 
the Document Information Panel, select Advanced 
Properties from the Document Properties dropdown 
list. In the Properties dialog, select the Custom tab. 

Visible, 
Clean 
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Parameter Description Default 
Delete 
document 
reviewers 
(Word) 

Microsoft Word only. If selected, removes information 
about all document reviewers who have made 
changes in the document. Track changes are not 
removed, but information about the user who made the 
change is removed. 
To see reviewers list: In MS Word, click the Review 
tab and from the Show Markup dropdown list 
(Tracking group), select Reviewers. 

Note: Clearing reviewers but not track changes, 
may be useful if you are collaborating on a 
document with an external party who uses track 
changes. You can retain the actual track changes 
made in the document, but you can remove 
confidential information about the author within your 
organization that made the change. 

Visible, 
Clean 

Delete 
document 
variables 
(Word) 

Microsoft Word only. If selected, deletes all document 
variables. 
Document variables are values stored in Microsoft 
Word documents that are used by either field codes or 
macros. These variables may contain confidential 
information like company names, or file locations. 
Even if field codes and macros are removed, the 
variables used may remain in the document. 
Variables can be viewed in Microsoft Word in the 
Visual Basic Editor. 

Visible, 
Clean 

Delete 
footers 
(Excel and 
PowerPoint) 

Microsoft Excel and PowerPoint. If selected, removes 
any footers included in the sheet or slide. 
To view headers and footers: Click the Insert tab and 
select Header & Footer (Text group). 

Visible, 
Clean 

Delete 
footnotes 
(Word) 

Microsoft Word only. If selected, removes any 
footnotes or endnotes included in the document. 

Visible, No 
clean 

Delete 
headers 
(Excel and 
PowerPoint) 

Microsoft Excel and PowerPoint. If selected, removes 
any headers included in the sheet or slide. 
To view headers and footers: Click the Insert tab and 
select Header & Footer (Text group). 

Visible, 
Clean 
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Parameter Description Default 
Delete hidden 
slides 
(PowerPoint) 

Microsoft PowerPoint only. If selected, removes 
hidden slides from Microsoft PowerPoint files. Hidden 
slides are not required for a slide show (they are not 
automatically displayed during a slide show) but they 
may contain confidential information. 

Visible, 
Clean 

Delete hidden 
text (Word) 

Microsoft Word only. If selected, removes all text that 
has been formatted as hidden. 
To view hidden text: Click the File menu/Office Button, 
select Options/Word Options and then select 
Display. Select the Hidden Text checkbox. 

Visible, 
Clean 

Delete ink 
annotations 
(Lightspeed 
Clean only) 

Microsoft Word, Excel and PowerPoint. If selected, 
removes ink annotations made in Tablet PC. Ink 
annotations are only removed by a Lightspeed clean. 

Visible, 
Clean 

Delete links 
(Excel) 

Microsoft Excel only. If selected, converts external 
links in Microsoft Excel files to text. The following are 
examples of external links: 
Link to a cell in another Microsoft Excel document. 
Named link to a named reference in another Microsoft 
Excel document. 
Link to another document. 
OLE link that inserts another document as an icon. 
OLE link that inserts another document as text. 

Visible, 
Clean 

Delete 
macros 
(Word and 
Excel) 

Microsoft Word and Excel. If selected, removes VBA 
macros from the document. This feature is not 
intended as virus protection, but rather to protect any 
confidential information, intellectual property or 
formulas included in the macros. 
To view macros: In MS Word, click the View tab and 
select Macros and then View Macros. 

Visible, 
Clean 

Delete 
markups 
(PDF) 

PDF. If selected, removes any markup in a PDF file. 
Markup is a tool used to make comments and 
annotations to PDF documents. 

Visible, 
Clean 

Delete 
previous 
authors 
(Word) 

Microsoft Word only. If selected, removes information 
about all authors who have previously saved the 
document as well as save locations. 
This information cannot be viewed from within 
Microsoft Word but it is visible from Microsoft Word if 
the file is opened in recovered text mode. 

Visible, 
Clean 
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Parameter Description Default 
Delete 
properties 
(PDF)  

PDF. If selected, removes properties in a PDF file. 

Standard properties are details about a file that help 
identify it, including its title, subject, author, manager, 
company, category, keywords, comments, and 
hyperlink base. 

Note: Removing properties from a PDF/A file will 
disable its PDF/A status. 

Visible, No 
clean 

Delete 
routing slip 
(Word and 
Excel 2003) 

Microsoft Word and Excel. If selected, removes all 
entries from a routing slip, as well as the message 
subject and text. This can prevent email addresses of 
colleagues from being unknowingly distributed. This 
also deletes any envelope information, such as 
recipients, subject and introduction, which are used 
when sending to a mail recipient. 
Routing slips are not supported in MS Office 2007 and 
above. 

Visible, 
Clean 

Delete Smart 
Tags (Word 
2003/2007) 

Microsoft Word only. If selected, removes smart tags 
from Microsoft Word documents. 
Smart tags are added to your documents as you 
create them if the option is enabled. These tags are 
linked to particular text in a document, such as a 
name, and allow you to perform certain actions by 
selecting the link associated with the text. Depending 
on the smart tag functions you use, they may embed 
extra hidden information in your document. 
Smart tags only exist in Microsoft Office XP to 2010. 
To manage smart tags: In MS Word 2007, click the 
Office Button, select Word Options and then select 
Proofing. Click the AutoCorrect Options button and 
select the Smart Tags tab. 

Visible, 
Clean 

Delete 
Speaker 
Notes 
(PowerPoint) 

Microsoft PowerPoint only. If selected, deletes all text 
that appears on the Notes Page in a Microsoft 
PowerPoint presentation. This is usually used by 
speakers to remind them of points during a 
presentation. You may want to remove speaker notes 
before distributing a presentation, as they are not 
usually intended for others to read. 

Visible, 
Clean 
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Parameter Description Default 
Delete text 
smaller than 
5pt (Word) 

Microsoft Word only. If selected, removes all text that 
has been formatted with a font size less that 5pt (i.e. 
4pt and less).  
To view small text: Click the View tab, select Zoom 
and specify a percentage greater than 100%. 

Visible, No 
clean 

Delete 
versions 
(Word 2003) 

Microsoft Word only. If selected, removes any previous 
versions of the document that you may have saved. 
Previous versions can be useful while you are 
developing a document, but often they can contain 
confidential information that you have removed from 
the main document. 
Document versions are not supported in MS Word 
2007 and above. 

Visible, 
Clean 

Delete white 
text on white 
background 
(Word) 

Microsoft Word only. Removes all text with a white font 
that has been formatted with a white background color. 
To view such text: Click the Page Layout tab and 
select a color from the Page Color dropdown list 
(Page Background group). 

Visible, No 
clean 

Reset 
document 
statistics 
(Word) 

Microsoft Word only. If selected, resets all the 
document statistics - total edit time, revision number, 
last authors, and file dates. 
To view statistics: In MS Office 2010/2013, click the 
File menu, select Info and then select Advanced 
Properties from the Properties dropdown list in the 
right panel. In the Properties dialog, select the 
Statistics tab. In MS Office 2007, click the Office 
Button, select Prepare and then select Properties. In 
the Document Information Panel, select Advanced 
Properties from the Document Properties dropdown 
list. In the Properties dialog, select the Statistics tab. 

Note: This information cannot be cleaned from 
within Microsoft Word. 

Visible, 
Clean 

Turn off 
versioning 
(Word 2003) 

Microsoft Word only. If selected, turns off the flag to 
automatically save a new version of the document 
every time the document is closed. This applies to 
local file systems only. Versions can still be saved 
manually by saving a file with a different name. 
Versioning is not supported in MS Word 2007 and 
above. 

Visible, 
Clean 
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Parameter Description Default 
Allow users 
to change 
metadata 
removal 
options 

Administrator Mode only. 
If selected, users can modify the individual metadata 
options selected in the Clean files section of the 
Interactive Protect panel. 

Selected 

Allow users 
to change 
PDF options 

Administrator Mode only. 
If selected, users can modify the individual pdf options 
selected in the Convert to PDF section of the 
Interactive Protect panel. 

Selected 

Allow users 
to compress 
to zip 

Administrator Mode only. 
If selected, the Compress all to zip section is visible 
to the user in the Interactive Protect panel. 

Selected 

Allow users 
to convert to 
pdf 

Administrator Mode only. 
If selected, the Convert to PDF section is visible to 
the user in the Interactive Protect panel. 

Selected 

Allow users 
to share files 
on 
Workshare 

Administrator Mode only. 
If selected, the Convert to link section is visible to the 
user in the Interactive Protect panel. 

Selected 

Auto apply 
on send for 
external 
emails 

Administrator Mode only. 
If selected, when a user does NOT click Apply in the 
Interactive Protect panel, the Interactive Protect 
settings from the Interactive Protect panel will still be 
applied when the user clicks Send. This parameter 
applies to external emails only. 
If not selected and the user forgets to click Apply 
before sending an external email, the email is sent 
without processing by Protect. 

Selected 

Auto apply 
on send for 
internal 
emails 

Administrator Mode only. 
If selected, when a user does NOT click Apply in the 
Interactive Protect panel, the Interactive Protect 
settings from the Interactive Protect panel will still be 
applied when the user clicks Send. This parameter 
applies to internal emails only. 
If not selected and the user forgets to click Apply 
before sending an internal email, the email is sent 
without processing by Protect. 

Not 
selected 
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Parameter Description Default 
Automatically 
select 
‘Convert to 
link’ when 
total 
attachment 
size exceeds 
(MB) 

Administrator Mode only. 
When attachments exceed the size specified then the 
Replace all attachments with a link checkbox in the 
Interactive Protect panel will be selected by default. 

 

Automatically 
show panel 
when: 

Administrator Mode only. 
Determines when the Interactive Protect panel will be 
automatically displayed in an email window. The 
options are: Any attachment is added, Metadata is 
detected, Always, Never. 

Note: If the Interactive Protect panel is set to never 
open automatically, users can display it by clicking 
the notification across the top of the email window or 
click Protect Files in the Message tab. 

Any 
attachment 
is added 

Default for 
‘Set an 
access 
expiry date’ 
(days) 

Administrator Mode only. 
When a number is specified, the Set an access 
expiry date checkbox in the Interactive Protect panel 
will be selected by default and the expiry date will be 
set to the specified number of days after today. 

 

Display 
progress 
when auto-
applying on 
send 

Administrator Mode only. 
If selected, when either of the Auto apply… 
parameters are selected and the Interactive Protect 
settings are automatically applied when the user clicks 
Send, a progress bar is displayed. 

Selected 

Select ‘Get 
return 
receipt’ 
checkbox by 
default 

Administrator Mode only. 
If selected, the Get return receipt checkbox in the 
Convert to link section of the Interactive Protect panel 
is selected by default. 

Not 
selected 

Select 
‘Recipients 
can 
download 
files’ 
checkbox by 
default 

Administrator Mode only. 
If selected, the Recipients can download files 
checkbox in the Convert to link section of the 
Interactive Protect panel is selected by default. 

Selected 



 

21 

Workshare 9 Configuration Options 

Parameter Description Default 
Select 
‘Recipients 
can invite 
others to this 
folder’ 
checkbox by 
default 

Administrator Mode only. 
If selected, the Recipients can invite others to this 
folder checkbox in the Convert to link section of the 
Interactive Protect panel is selected by default. 

Selected 

Select 
‘Recipients 
must login to 
access files’ 
checkbox by 
default 

Administrator Mode only. 
If selected, the Recipients must login to access files 
checkbox in the Convert to link section of the 
Interactive Protect panel is selected by default. 

Selected 

Select 
‘Remove 
metadata’ 
checkbox by 
default 

Administrator Mode only. 
If selected, the Remove metadata checkbox in the 
Clean files section of the Interactive Protect panel is 
selected by default. 

Selected 

Protection>Remove Metadata 
The Protection > Remove Metadata parameters enable you to specify what metadata 
should be removed by Workshare Protect in the following situations: 

• Email attachments sent to internal recipients 

• Email attachments sent to external recipients 

• Open Microsoft Office documents (when discovering and removing content risk) 

The parameters in this category list the types of metadata that can be removed by 
Workshare Protect. To select a metadata type, you select the checkbox to the right of 
the parameter in the relevant column – Internal Email, External Email, Content Risk. 

Tip! You can select all parameters in a column by selecting the checkbox in the 
column header and then deselect one or two metadata parameters within that column 
as required. 
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The Protection > Remove Metadata parameters are described in the following table: 

Parameter Description Default 
Accept changes and turn 
off Track Changes (Word 
and Excel) 

Microsoft Word and Excel. 
If selected, accepts all 
revisions made to the 
document. The revisions 
are therefore no longer 
displayed as revisions but 
rather as text in the 
document. Track changes 
is also turned off so that 
further revisions are not 
tracked. 

Internal: Not selected 

External: Not selected 

Content Risk: Not selected 
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Parameter Description Default 
Convert attached 
template to Normal 
(Word) 

Microsoft Word only. If 
selected, converts the 
attached template to 
normal.dot. Automatic 
style updating is disabled 
before the template is 
removed. Therefore the 
formatting and styles in 
your document will not be 
affected by removing the 
attached template. 
To view the attached 
template: Click the File 
menu/Office Button, select 
Options/Word Options 
and then select Add-Ins. 
From the Manage 
dropdown list, select Word 
Add-ins and click Go. 

Internal: Selected 

External: Selected 

Content Risk: Selected 
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Convert field codes to 
text (Office) 

Microsoft Word, Excel and 
PowerPoint. If selected, 
converts any field codes 
that exist in a Microsoft 
Word document to text, for 
example, hyperlinks, table 
of contents, index. In 
Microsoft Excel and 
PowerPoint, hyperlinks are 
converted to text. 

Note: For Microsoft 
Excel and PowerPoint, 
hyperlinks are the only 
field codes that exist. 

This prevents the field 
codes from being updated 
after you have distributed 
the document. It also 
prevents errors for fields 
that reference built-in or 
custom properties that 
have been removed. 

Note: You can prevent 
certain field codes from 
being cleaned, for 
example, table of 
contents or page 
numbers, by selecting 
them in the Protection 
> Exclude Metadata 
category. Refer to 
page 38. 

To view field codes: Click 
the File menu/Office 
Button, select 
Options/Word Options 
and then select 
Advanced. Select the 
Show field codes instead 
of their values checkbox 
in the Show document 
content area. 

Internal: Selected 

External: Selected 

Content Risk: Selected 
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Parameter Description Default 
Delete attachments 
(PDF) 

PDF. If selected, removes 
any attachments to a PDF 
file. 

PDF attachments are 
separate files attached to 
a PDF file generally or 
linked to a specific point in 
a PDF file. Selecting this 
option will only remove the 
first type of attachment. 
Attachments linked to a 
specific point in a PDF file 
are treated as markups 
and will only be removed if 
the Delete markups 
parameter is selected. 

Internal: Selected 

External: Selected 

Delete bookmarks (PDF) PDF. If selected, removes 
any bookmarks in a PDF 
file. 

Internal: Selected 

External: Selected 
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Parameter Description Default 
Delete built-in properties 
(Office) 

Microsoft Word, Excel and 
PowerPoint. If selected, 
removes all summary 
properties - author, 
category, comments, 
company, keywords, 
manager, title, subject, 
and hyperlink base; and 
custom properties – text, 
date and number. 
To view built-in properties: 
In MS Office 2010/2013, 
click the File menu, select 
Info and then select 
Advanced Properties 
from the Properties 
dropdown list in the right 
panel. In the Properties 
dialog, select the 
Summary and Contents 
tabs. In MS Office 2007, 
click the Office Button, 
select Prepare and then 
select Properties. In the 
Document Information 
Panel, select Advanced 
Properties from the 
Document Properties 
dropdown list. In the 
Properties dialog, select 
the Summary and 
Contents tabs. 

Internal: Selected 

External: Selected 

Content Risk: Selected 
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Parameter Description Default 
Delete comments 
(Office) 

Microsoft Word, Excel and 
PowerPoint. If selected, 
removes any comments 
embedded in the 
document. 
By default this parameter 
is not selected. 
To display comments: In 
MS Office 2010/2013, click 
the Review tab and from 
the Show Markup 
dropdown list (Tracking 
group), select Balloons 
then Show Only 
Comments and 
Formatting in Balloons. 
In MS Office 2007, click 
the Review tab and from 
the Balloons dropdown 
list (Tracking group), 
select Show Only 
Comments and 
Formatting in Balloons. 

Internal: Not selected 

External: Not selected 

Content Risk: Not selected 
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Parameter Description Default 
Delete custom 
properties (Office) 

Microsoft Word, Excel and 
PowerPoint. If selected, 
removes any custom 
properties that have been 
added to the document. 

Note: You can prevent 
certain custom 
properties from being 
cleaned, for example, 
DMS Doc ID Properties, 
by selecting them in the 
Protection > Exclude 
Metadata category. 
Refer to page 38. 

To view document 
properties: In MS Office 
2010/2013, click the File 
menu, select Info and then 
select Advanced 
Properties from the 
Properties dropdown list 
in the right panel. In the 
Properties dialog, select 
the Custom tab. In MS 
Office 2007, click the 
Office Button, select 
Prepare and then select 
Properties. In the 
Document Information 
Panel, select Advanced 
Properties from the 
Document Properties 
dropdown list. In the 
Properties dialog, select 
the Custom tab. 

Internal: Selected 

External: Selected 

Content Risk: Selected 
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Parameter Description Default 
Delete document 
reviewers (Word) 

Microsoft Word only. If 
selected, removes 
information about all 
document reviewers who 
have made changes in the 
document. Track changes 
are not removed, but 
information about the user 
who made the change is 
removed. 
To see reviewers list: In 
MS Word, click the 
Review tab and from the 
Show Markup dropdown 
list (Tracking group), 
select Reviewers. 

Note: Clearing 
reviewers but not track 
changes, may be useful 
if you are collaborating 
on a document with an 
external party who uses 
track changes. You can 
retain the actual track 
changes made in the 
document, but you can 
remove confidential 
information about the 
author within your 
organization that made 
the change. 

Internal: Selected 

External: Selected 

Content Risk: Selected 
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Parameter Description Default 
Delete document 
variables (Word) 

Microsoft Word only. If 
selected, deletes all 
document variables. 
Document variables are 
values stored in Microsoft 
Word documents that are 
used by either field codes 
or macros. These 
variables may contain 
confidential information 
like company names, or 
file locations. Even if field 
codes and macros are 
removed, the variables 
used may remain in the 
document. 
Variables can be viewed in 
Microsoft Word in the 
Visual Basic Editor. 

Internal: Selected 

External: Selected 

Content Risk: Selected 

Delete footers (Excel and 
PowerPoint) 

Microsoft Excel and 
PowerPoint. If selected, 
removes any footers 
included in the sheet or 
slide. 
To view headers and 
footers: Click the Insert 
tab and select Header & 
Footer (Text group). 

Internal: Selected 

External: Selected 

Content Risk: Selected 

Delete footnotes (Word) Microsoft Word only. If 
selected, removes any 
footnotes or endnotes 
included in the document. 

Internal: Not selected 

External: Not selected 

Content Risk: Not selected 
Delete headers (Excel 
and PowerPoint) 

Microsoft Excel and 
PowerPoint. If selected, 
removes any headers 
included in the sheet or 
slide. 
To view headers and 
footers: Click the Insert 
tab and select Header & 
Footer (Text group). 

Internal: Selected 

External: Selected 

Content Risk: Selected 
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Parameter Description Default 
Delete hidden slides 
(PowerPoint) 

Microsoft PowerPoint only. 
If selected, removes 
hidden slides from 
Microsoft PowerPoint files. 
Hidden slides are not 
required for a slide show 
(they are not automatically 
displayed during a slide 
show) but they may 
contain confidential 
information. 

Internal: Selected 

External: Selected 

Content Risk: Selected 

Delete hidden text 
(Word) 

Microsoft Word only. If 
selected, removes all text 
that has been formatted as 
hidden. 
To view hidden text: Click 
the File menu/Office 
Button, select 
Options/Word Options 
and then select Display. 
Select the Hidden Text 
checkbox. 

Internal: Selected 

External: Selected 

Content Risk: Selected 

Delete ink annotations 
(Lightspeed Clean only) 

Microsoft Word, Excel and 
PowerPoint. If selected, 
removes ink annotations 
made in Tablet PC. Ink 
annotations are only 
removed by a Lightspeed 
clean. 

Internal: Selected 

External: Selected 

Content Risk: Selected 
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Parameter Description Default 
Delete links (Excel) Microsoft Excel only. If 

selected, converts external 
links in Microsoft Excel 
files to text. The following 
are examples of external 
links: 
Link to a cell in another 
Microsoft Excel document. 
Named link to a named 
reference in another 
Microsoft Excel document. 
Link to another document. 
OLE link that inserts 
another document as an 
icon. 
OLE link that inserts 
another document as text. 

Internal: Selected 

External: Selected 

Content Risk: Selected 

Delete macros (Word 
and Excel) 

Microsoft Word and Excel. 
If selected, removes VBA 
macros from the 
document. This feature is 
not intended as virus 
protection, but rather to 
protect any confidential 
information, intellectual 
property or formulas 
included in the macros. 
To view macros: In MS 
Word, click the View tab 
and select Macros and 
then View Macros. 

Internal: Selected 

External: Selected 

Content Risk: Selected 

Delete markups (PDF) PDF. If selected, removes 
any markup in a PDF file. 

Markup is a tool used to 
make comments and 
annotations to PDF 
documents. 

Internal: Selected 

External: Selected 
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Parameter Description Default 
Delete previous authors 
(Word) 

Microsoft Word only. If 
selected, removes 
information about all 
authors who have 
previously saved the 
document as well as save 
locations. 
This information cannot be 
viewed from within 
Microsoft Word but it is 
visible from Microsoft 
Word if the file is opened 
in recovered text mode. 

Internal: Selected 

External: Selected 

Content Risk: Selected 

Delete properties (PDF) PDF. If selected, removes 
properties in a PDF file. 

Standard properties are 
details about a file that 
help identify it, including its 
title, subject, author, 
manager, company, 
category, keywords, 
comments, and hyperlink 
base. 

Note: Removing 
properties from a PDF/A 
file will disable its PDF/A 
status. 

Internal: Not selected 

External: Not selected 
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Parameter Description Default 
Delete routing slip (Word 
and Excel 2003) 

Microsoft Word and Excel. 
If selected, removes all 
entries from a routing slip, 
as well as the message 
subject and text. This can 
prevent email addresses 
of colleagues from being 
unknowingly distributed. 
This also deletes any 
envelope information, such 
as recipients, subject and 
introduction, which are 
used when sending to a 
mail recipient. 
Routing slips are not 
supported in MS Office 
2007 and above. 

Internal: Selected 

External: Selected 

Content Risk: Selected 
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Parameter Description Default 
Delete Smart Tags (Word 
2003/2007) 

Microsoft Word only. If 
selected, removes smart 
tags from Microsoft Word 
documents. 
Smart tags are added to 
your documents as you 
create them if the option is 
enabled. These tags are 
linked to particular text in a 
document, such as a 
name, and allow you to 
perform certain actions by 
selecting the link 
associated with the text. 
Depending on the smart 
tag functions you use, they 
may embed extra hidden 
information in your 
document. 
Smart tags only exist in 
Microsoft Office XP to 
2010. 
To manage smart tags: In 
MS Word 2007, click the 
Office Button, select Word 
Options and then select 
Proofing. Click the 
AutoCorrect Options 
button and select the 
Smart Tags tab. 

Internal: Selected 

External: Selected 

Content Risk: Selected 

Delete Speaker Notes 
(PowerPoint) 

Microsoft PowerPoint only. 
If selected, deletes all text 
that appears on the Notes 
Page in a Microsoft 
PowerPoint presentation. 
This is usually used by 
speakers to remind them 
of points during a 
presentation. You may 
want to remove speaker 
notes before distributing a 
presentation, as they are 
not usually intended for 
others to read. 

Internal: Selected 

External: Selected 

Content Risk: Selected 
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Parameter Description Default 
Delete text smaller than 
5pt (Word) 

Microsoft Word only. If 
selected, removes all text 
that has been formatted 
with a font size less that 
5pt (i.e. 4pt and less).  
To view small text: Click 
the View tab, select Zoom 
and specify a percentage 
greater than 100%. 

Internal: Not selected 

External: Not selected 

Content Risk: Not selected 

Delete versions (Word 
2003) 

Microsoft Word only. If 
selected, removes any 
previous versions of the 
document that you may 
have saved. Previous 
versions can be useful 
while you are developing a 
document, but often they 
can contain confidential 
information that you have 
removed from the main 
document. 
Document versions are not 
supported in MS Word 
2007 and above. 

Internal: Selected 

External: Selected 

Content Risk: Selected 

Delete white text on 
white background 
(Word) 

Microsoft Word only. 
Removes all text with a 
white font that has been 
formatted with a white 
background color. 
To view such text: Click 
the Page Layout tab and 
select a color from the 
Page Color dropdown list 
(Page Background 
group). 

Internal: Not selected 

External: Not selected 

Content Risk: Not selected 
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Parameter Description Default 
Reset document 
statistics (Word) 

Microsoft Word only. If 
selected, resets all the 
document statistics - total 
edit time, revision number, 
last authors, and file dates. 
To view statistics: In MS 
Office 2010/2013, click the 
File menu, select Info and 
then select Advanced 
Properties from the 
Properties dropdown list 
in the right panel. In the 
Properties dialog, select 
the Statistics tab. In MS 
Office 2007, click the 
Office Button, select 
Prepare and then select 
Properties. In the 
Document Information 
Panel, select Advanced 
Properties from the 
Document Properties 
dropdown list. In the 
Properties dialog, select 
the Statistics tab. 

Note: This information 
cannot be cleaned from 
within Microsoft Word. 

Internal: Selected 

External: Selected 

Content Risk: Selected 

Turn off versioning 
(Word 2003) 

Microsoft Word only. If 
selected, turns off the flag 
to automatically save a 
new version of the 
document every time the 
document is closed. This 
applies to local file 
systems only. Versions 
can still be saved manually 
by saving a file with a 
different name. 
Versioning is not 
supported in MS Word 
2007 and above. 

Internal: Selected 

External: Selected 

Content Risk: Selected 
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Protection>Exclude Metadata 
The Protection>Exclude Metadata parameters enable you to exclude certain types of 
metadata from being removed when documents are cleaned. The types of metadata 
that can be excluded from cleaning are custom properties and field codes from Office 
documents and markups from PDF files. When cleaning, the user can still select to 
clean these types of metadata and all custom properties, field codes or markups will be 
cleaned, except for the ones explicitly excluded here. These parameters apply when 
Workshare Protect is cleaning attachments as well as cleaning open Microsoft Office 
documents. 

Note: When field codes are cleaned, the text is not removed. The field code is simply 
unlinked so that it is not updated in the future. For example, if you have a table of 
contents field code. Unlinking it keeps the table of contents in your document, but you 
are unable to update the table of contents, as it is no longer a field; it is only text. 
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The Protection > Exclude Metadata parameters which apply to all cleaning (internal 
email, external email and open documents) are described in the following table:  

Parameter Description Default 
Delete 
specified 
field codes 

Microsoft Word only. Workshare Protect is configured 
to replace field codes with static text. However, by 
entering the field codes in this parameter, Workshare 
Protect will delete any instances of these field codes. 
To delete specific field codes, add the name of the field 
code to this parameter. If you want to specify more 
than one field code you can do so by separating each 
field code with a semicolon.  

 

Exclude 
Annotation 
Links (PDF) 

PDF only. Annotation links are a type of markup and 
provide links to other areas within the same PDF or to 
another PDF. 
If selected, any annotation links in PDF files are not 
cleaned. 
By default, annotation links are not excluded and 
therefore annotation links are unlinked during cleaning. 

Not 
Selected 

Exclude 
Annotation 
Widgets 
(PDF) 

PDF only. Annotation widgets are a type of markup 
and are used to represent the appearance of fields. 
If selected, any annotation widgets in PDF files are not 
cleaned. 
By default, annotation widgets are not excluded and 
therefore annotation widgets are unlinked during 
cleaning. 

Not 
Selected 

Exclude field 
codes for 
form fields 

Microsoft Word only. These are field codes that are 
used in forms, for example, dropdown lists and text 
boxes. 
If selected, any form field codes are not cleaned. 
By default, these field codes are not excluded and 
therefore form fields are unlinked during cleaning.  

Not 
Selected 

Exclude field 
codes for 
Include fields 

Microsoft Word only. These are field codes that include 
text or pictures from other sources. 
If selected, any ‘include’ field codes are not cleaned. 
By default, these field codes are not excluded and 
therefore ‘include’ fields are unlinked during cleaning. 

Not 
selected 

Exclude field 
codes for 
Link fields 

Microsoft Word only. These are field codes for linked 
or imported objects. 
If selected, the links are not removed and therefore still 
update from the source. 
By default, these field codes are not excluded and 
therefore links are unlinked during cleaning. 

Not 
selected 
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Parameter Description Default 
Exclude field 
codes for 
Reference 
fields 

Microsoft Word only. These are field codes for any 
references within the document, for example, page 
references. 
If not selected, references are unlinked and therefore 
no longer automatically updated. 
By default, these field codes are excluded and 
therefore any references in your document remain fully 
functional. 

Selected 

Exclude field 
codes in 
Document 
Automation 
group 

Microsoft Word only. These are field codes used to 
provide functions within a document, for example, 
macro buttons, mail merge functions, print 
functionality. 
If selected, these field codes remain linked which 
means the document automation features continue to 
work. 
By default these field codes are not excluded, and 
therefore document automation features are unlinked 
during cleaning.  

Not 
selected 

Exclude field 
codes in 
Document 
Information 
group 

Microsoft Word only. These are field codes that 
reference any of the document properties, for example, 
subject and keywords, as well as any field codes that 
reference the document statistics, for example, create 
date and number of words. 
If selected, any field codes referencing the document 
properties or statistics are not cleaned. 
By default, these field codes are not excluded and 
therefore document information is unlinked during 
cleaning. 

Not 
selected 

Exclude field 
codes in 
Equations 
and 
Formulas 
group 

Microsoft Word only. These are field codes for 
calculations, for example, equations, symbols or 
formula. 
If selected, equations remain linked. 
By default, these field codes are not excluded and 
therefore any equations are unlinked during cleaning. 

Not 
selected 
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Parameter Description Default 
Exclude field 
codes in 
Index and 
Tables group 

Microsoft Word only. These are field codes related to 
the Table of Contents, Table of Authorities, Glossary, 
and Index. 
If not selected, these tables are unlinked, and can 
therefore no longer be automatically updated.  
By default, these field codes are excluded and 
therefore Tables and Indexes in your document will 
remain fully functional.  

Note: Unlinking a Table of Contents causes the 
hyperlinks that reference each section of the 
document to stop working. It may also change the 
format of the Table of Contents to blue underlined 
text.  

Selected 

Exclude field 
codes in 
Numbering 
group 

Microsoft Word only. These are field codes for 
numbering within the document, for example, page 
numbers, list numbers, section numbers. 
If not selected, these numbers are unlinked and 
therefore no longer automatically updated. 
By default, these field codes are excluded and 
therefore any numbering in your document remains 
fully functional. 

Note: Unlinking page numbers in headers or footers 
may cause page numbers to be repeated if a header 
or footer is shared between more than one page of 
the document. 

Selected 

Exclude field 
codes with 
author 
information 

Microsoft Word only. These are field codes that include 
the Author, Last Saved By User, or Current User 
information. 
If selected, any field codes referencing the author or 
user are not cleaned. 
By default, these field codes are not excluded and 
therefore author information is unlinked during 
cleaning. 

Not 
selected 
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Parameter Description Default 
Exclude field 
codes with 
hyperlinks 

Microsoft Word, Excel and PowerPoint. These are field 
codes for hyperlinks. 
If not selected, hyperlinks are unlinked. The text of the 
link is still visible but the associated address is 
removed. 
By default, these field codes are excluded and 
therefore hyperlinks in your document remain fully 
functional. 

Selected 

Exclude 
specified 
custom 
properties 

Microsoft Word, Excel and PowerPoint. If you have 
custom properties in your documents that you never 
want to remove, for example, DMS DocIds, you can 
exclude them from both cleaning and discovery. To 
exclude custom properties, add the names of the 
custom properties to this parameter. If you want to 
specify more than one property you can do so by using 
a semicolon. 

 

Exclude 
specified 
document 
variables 

Microsoft Word only. If you have document variables in 
your documents that you never want to remove, you 
can exclude them from both cleaning and discovery. 
To exclude document variables, add the names of the 
document variable to this parameter. If you want to 
specify more than one document variable you can do 
so by using a semicolon.  

 

Exclude 
specified 
field codes 

Microsoft Word only. If you have field codes in your 
documents that you never want to remove, you can 
exclude them from both cleaning and discovery. To 
exclude specific field codes, add the name of the field 
code to this parameter. If you want to specify more 
than one field code you can do so by separating each 
field code with a semicolon. 
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Protection>Convert to PDF 
The Protection>Convert to PDF parameters enable you to specify whether Workshare 
Protect should convert attachments to PDF as well as set the default security settings 
applied when Workshare Protect performs conversion to PDF. 

 
The Protection > Convert to PDF parameters are described in the following table: 

Parameter Description Default 
Convert 
attachments 
to PDF 

If selected, Microsoft Office documents attached to the 
email are automatically converted to PDFs when the 
email is sent.  

Internal: 
Not 
selected 

External: 
Not 
selected 

Clean before 
PDF 

If selected, documents are cleaned before they are 
converted to PDF according to the parameters 
selected in Protection>Remove Metadata (Content 
Risk column). 

Not 
selected 
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Parameter Description Default 
Default 
password to 
apply PDF 
security 

Administrator Mode Only. 
The default password required to access PDF security 
options or to access PDF files when security options 
are applied. 

Contact 
Workshare 
Customer 
Support 

Default 
password to 
open PDF 

The default password required to open PDF files after 
conversion by Workshare Protect. 

 

Enable 
PostScript 
simulation 

If selected, the PostScript simulation option in the 
printer driver is turned on. This option is relevant when 
converting documents to PDF that include WordArt 
and semi-transparent backgrounds. 

Not 
selected 

Multilingual 
Support 

If selected, when converting to PDF, Workshare 
embeds the documents’ fonts inside the PDF file. This 
means a PDF file can always be read even on 
machines that do not have the fonts of the document. 
Embedding the fonts into the PDF file will make the 
PDF file bigger. 

Selected 

Prohibit 
comments 
being added 

If selected, the Prevent comments being added 
checkbox in the PDF Security Settings dialog is 
selected by default. 

Not 
selected 

Prohibit 
modification 
of text 

If selected, the Prevent editing of text checkbox in 
the PDF Security Settings dialog is selected by default. 

Not 
selected 

Prohibit 
printing 

If selected, the Prevent printing checkbox in the PDF 
Security Settings dialog is selected by default. 

Not 
selected 

Prohibit text 
or graphics 
being copied 

If selected, the Prevent the copying of text and/or 
graphics checkbox in the PDF Security Settings dialog 
is selected by default. 

Not 
selected 

Reconstruct 
Hyperlinks 

If selected, standard URL and bookmark hyperlinks are 
preserved when converting to PDF. 

Note: Selecting the Reconstruct Hyperlinks 
parameter can increase the time it takes to create a 
PDF document. Hyperlinks that are preserved using 
this option may not correspond exactly to the 
location in the original document. 

Not 
selected 

Set PDF/A as 
default PDF 
format 

If selected, the PDF/A option is selected as the default 
when converting to PDF. 

Not 
selected 
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Protection>Compress as Zip 
The Protection>Compress as Zip parameters enable you to specify whether 
Workshare Protect should compress attachments into zip files and how it performs this 
functionality. 

 
The Protection > Compress as Zip parameters are described in the following table: 

Parameter Description Default 
Zip 
attachments 
above 
specified 
limit (MB) 

The size limit for zipping attachments. If this option is 
not selected and the text box left blank, no zipping is 
done. If this option is selected and set to 0, 
attachments are always zipped (unless they are 
already zipped). You can also set the value in the text 
box to a particular size, for example, 2. In this case 
zipping only occurs if attachments are larger than 2MB. 
Workshare Protect zips Microsoft Word, Excel and 
PowerPoint files as well as PDF and RTF files. Each 
attachment that meets the specified limit is zipped 
individually and attached the email instead of the 
unzipped file. 

Internal: 
Not 
selected 

External: 
Not 
selected 

Apply 
password 
when 
creating zip 
files 

If selected, users are prompted to enter a password 
whenever attachments are automatically zipped. This 
option is used in conjunction with the automatic zip 
options.  
When this setting is not selected, zip files are not 
password-protected. 

Not 
selected 
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Comparison>Administration 
The Comparison>Administration parameters enable you to specify how Workshare 
Compare functions in specific situations. 

 
The Comparison > Administration parameters are described in the following table: 

Parameter Description Default 
Additional 
locations for 
rendering 
sets 

Workshare Compare looks in the following two 
locations to create a list of the possible 
rendering sets available: 
%PUBLIC%\Documents\Workshare\Rendering 
(default public location) 
%USERPROFILE%\Documents\Workshare\Ren
dering (default user location). This may be 
different if the administrator has specified a new 
default user location for the Default rendering 
set location parameter. 
To specify other locations, for example, on your 
network, enter the location in this field. Separate 
multiple locations with a semi-colon. 
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Parameter Description Default 
Allow users 
to change 
email 
attachment 
format 

Administrator Mode only. 
If selected, the user can select from different 
formats for the Redline document when sending 
a Redline by email.  

Selected 

Apply 
Accepted 
Changes 
default save 
location 

The default save location of the new Word 
document that opens with your selected 
changes accepted, when you click the Apply 
Accepted Changes button in Workshare 
Compare. 

 

Attachment(s) 
Alert & 
Compare 
category 
name 

When the Automatic Change Notification 
functionality is enabled, the category name used 
in Microsoft Outlook to indicate that an email 
includes an attachment that has previously been 
sent out and that has now been modified. 

Attachment(s) 
Modified 

Default 
document 
open location 

The default location when opening saved 
comparisons using the Open option in 
Workshare Compare. 

 

Default email 
attachment 
format 

The default format for the Redline document 
when sending a Redline by email (DOC, DOCX, 
TEXT, RTF, WDF or PDF). 

Portable 
Document Format 
(.pdf) 

Default 
location 
rendering set 

Administrator Mode Only. 
The default user location where rendering sets 
are saved. 

%USERPROFILE
% 
\Documents\ 
Workshare\ 
Rendering 

Default 
Redline save 
location  

The default location where Redline documents 
are saved. 

 

Default 
rendering set 

The default rendering set to be applied to 
comparisons. If no default is specified, 
Workshare Compare uses the most recently 
used rendering set as the default. 
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Parameter Description Default 
Display 
document 
description 
as well as 
document ID 

If selected, DMS document descriptions are 
displayed in the Workshare Compare 
comparison window, where usually it would 
display document IDs. A DMS document ID is in 
the form file://c/mydocument.doc, whereas the 
description is more user friendly, for example, 
mydocument.doc. This applies to local file 
store as well as all other DMS integrations. 
Additionally, if selected, the most recently used 
list displays the more user friendly document 
description when a user is picking recent 
documents in a Workshare Compare 
comparison. 

Not selected 

Display 
document 
selection 
dialog on 
startup 

If selected, the Compare Documents dialog is 
displayed automatically when Workshare 
Compare is launched. 

Selected 

Display 
Redline in 
page layout 
view 

If selected, the Redline document is displayed in 
Page Layout view. 

Selected 

Display 
source 
document 
labels 

If selected, the names of the original and 
modified documents are displayed above them 
in the Source Documents window. 

Selected 

Display 
source 
documents in 
page layout 
view 

If selected, the original and modified documents 
are displayed in Page Layout view in the Source 
Documents window. 

Not selected 

Display table 
gridlines 

If selected, table gridlines are displayed in the 
Redline document and source documents. 

Selected 

Display 
Workshare 
Compare in 
Outlook 
Shortcuts 

If selected, the Compare shortcut is displayed in 
the Outlook Shortcuts Navigation pane. 

Not selected 

Drives 
without 
Windows file 
sharing 

If you are running NFS Hummingbird to map 
drives, the drive letters to which to save Redline 
documents. 

 

file://c/my
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Parameter Description Default 
Enable 
Attachment(s) 
Alert & 
Compare 

If selected, the Automatic Change Notification 
functionality is enabled. This means that when a 
user sends a document to a recipient and the 
recipient edits the document and sends it back 
to the user, Workshare Compare will 
automatically detect that the received 
attachment is a changed version of the original 
document and present the changes between the 
two documents. The Redline document as well 
as a summary of changes can be viewed 
directly in Microsoft Outlook or the user can 
open the Redline document from Microsoft 
Outlook directly into Workshare Compare. 

Selected 

Enable fast 
comparison 

If selected, the Fast comparison mode is 
available when comparing DOC and DOCX 
files. Using the Fast mode, Workshare Compare 
reads a document at a binary level and converts 
it to RTF format (faster than MS Word in 
Standard mode) and therefore completes the 
comparison more quickly. 
If you are experiencing issues with the 
document comparison, your Technical Support 
representative may request that you disable this 
option. Otherwise, it is not recommended to 
change this setting. 

Selected 

Enable 
reduced 
Redline 

If selected, the Redline document displays 
changes with limited surrounding text. 

Not selected 

Highlight 
changes in 
Redline on 
navigation 

If selected, the changes made to the original 
document are highlighted in the Redline 
document when you navigate to them. For 
example, by selecting a change in the Change 
Summary window. 

Selected 

Number of 
characters 
shown 
around a 
change in 
reduced 
Redline 

When a reduced Redline document is produced, 
this setting defines the number of characters 
that are displayed surrounding a change. By 
default, the number of surrounding characters is 
200; the minimum number of surrounding 
characters is 70. 

200 
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Parameter Description Default 
Only print 
pages with 
changes 

If selected, the Only print pages with changes 
checkbox in the Print dialog is selected by 
default. This option specifies that only the pages 
in Redline documents that include changes are 
printed. 

Not selected 

Print Redline 
in black and 
white 

If selected, the Print Redline in black and 
white checkbox in the Print dialog is selected by 
default. This option specifies that Redline 
documents are printed in monochrome (black 
and white). 

Not selected 

Prompt to 
save Redline 
after a 
comparison 

If selected, the Redline document is 
automatically saved after each comparison. 

Not selected 

Prompt to 
save Redline 
on close 

If selected, when closing Workshare Compare, 
a message is displayed prompting the user to 
save the Redline document. 

Selected 

Send Redline 
email body 

The text included in the body of the email when 
sending a Redline by email. The 
{ATTACHMENTS} tag means that the names of 
the attachments are included below the text. 
Remove this tag if you do not want the 
attachment names to appear. 

The following files 
have been 
attached to this 
mail by 
Workshare 
Professional… 
{ATTACHMENTS} 

Send Redline 
email subject 

The text displayed in the Subject field when 
sending a Redline by email. 

Workshare 
Professional 
Document 
Distribution 

Synchronize 
documents 
on navigation 

If selected, the views of the original, modified 
and Redline documents scroll to the same point 
when you click a paragraph in any of the 
documents. 

Selected 

Synchronize 
multiple 
Redlines on 
navigation 

If selected, when an original document has been 
compared against multiple modified documents, 
then the views of each Redline document (in 
their individual tabs) scroll to the same 
approximate point when you click a paragraph in 
any of the Redline documents. 

Selected 
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Parameter Description Default 
Use current 
instance of 
Word 

If selected, then only one instance of Microsoft 
Word is invoked in memory and the Workshare 
functions that are launched from outside 
Microsoft Word use an existing winword.exe 
process. 

Not selected 

Use current 
instance of 
Word when 
comparing 

If selected, then only one instance of Microsoft 
Word is invoked in memory and the Workshare 
functions that are launched from within 
Microsoft Word use an existing winword.exe 
process. 

Not selected 

Use Redline 
name as 
email subject 

If selected, the document name of the Redline 
document is used in the Subject field when 
sending a Redline by email. This setting will 
override any setting specified in the Send 
Redline email subject parameter. 

Not selected 

Zoom (%) The magnification of the source documents and 
the Redline document as they appear in the 
Workshare Compare main window. 

100 

Comparison>User Interface 
The Comparison >User Interface parameters enable you to customize the Workshare 
Compare user interface and set what options will be available. 
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The Comparison > User Interface parameters are described in the following table: 

Parameter Description Default 
Enable 
‘Close All’ 

If selected, enables the Close All option in Workshare 
Compare. The user is able to close all open Redline 
documents. 

Selected 

Enable 
convert to 
Track 
Change 
functionality 

If selected, the convert to track change functionality is 
available. This functionality enables you to save, share 
or open the Redline as a document with track 
changes. 

Selected 

Enable 
‘Email’ 

If selected, enables the Email option in Workshare 
Compare. The user is able to send the Redline and 
source documents by email. 

Selected 

Enable 
‘Email > 
Attach as 
PDF (only 
pages with 
changes)’ 

If selected, the Email > Attach as PDF (only pages 
with changes) option is available in Workshare 
Compare. This option enables you to email only the 
pages from the Redline that include changes. 

Selected 

Enable 
‘Email > 
Attach as 
Word 
document 
with Track 
Changes’ 

If selected, the Email > Attach as Word document 
with Track Changes option is available in Workshare 
Compare. This option enables you to convert the 
Redline to a document with track changes and email it. 

Selected 

Enable ‘New 
Comparison’ 

If selected, enables the New Comparison option in 
Workshare Compare. The user is able to perform a 
new comparison. 

Selected 

Enable ‘Open 
Comparison’ 

If selected, enables the Open Comparison option in 
Workshare Compare. The user is able to open a saved 
comparison (WDF). 

Selected 

Enable ‘Open 
in Word’ 

If selected, enables the Word > Open in Word option 
in Workshare Compare. The user is able to edit the 
Redline document in their chosen word processor. The 
word processor must be configured to open rich text 
format files (.rtf). 

Note: If the user does this, the Redline document is 
no longer an accurate reflection of the changes 
between the original and modified documents.  

Selected 
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Parameter Description Default 
Enable ‘PDF’ If selected, enables the PDF option in Workshare 

Compare. The user is able to convert the Redline to 
PDF. 

Selected 

Enable ‘Save 
to My Files’ 

If selected, enables the Save to My Files option in 
Workshare Compare. The user is able to save a 
Redline document to Workshare online. 

Selected 

Enable 
‘Share’ 

If selected, enables the Share option in Workshare 
Compare. The user is able to share and collaborate on 
a Redline document in Workshare online. 

Selected 

Comparison>Rendering Sets 
The Comparison >Rendering Sets parameters enable you to configure the Workshare 
Compare rendering set functionality as well as set what rendering set options will be 
available. 
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The Comparison > Rendering Sets parameters are described in the following table:  

Parameter Description Default 
Allow use of 
custom user 
rendering 
sets 

Administrator Mode only. 
If selected, Workshare Compare includes the 
rendering sets in the personal rendering sets location 
(C: Users > (user name) > My Documents > 
Workshare > Rendering) when populating the list of 
possible rendering sets available. 

Selected 

Allow users 
to create new 
rendering 
sets (save 
as) 

Administrator Mode only. 
If selected, the user can create new rendering sets 
using the Save As button in the Rendering Sets 
Manager. 

Selected 

Allow users 
to save and 
delete 
rendering 
sets 

Administrator Mode only. 
If selected, the user can save and delete rendering 
sets using the Save and Delete buttons in the 
Rendering Sets Manager. 

Selected 

Prompt to 
save 
rendering set 

If selected, when a user is creating their own rendering 
set, they are prompted to save their changes under a 
different name. 

Selected 

Show 
Change 
Numbering 
parameters 
in Redline 
Rendering 

If selected, the Change Numbering parameters in the 
Redline Rendering category of the Rendering Set 
Manager are available to the user enabling the user to 
switch change numbering on and off in the Redline 
document and change how change numbering is 
displayed.  

Selected 

Show 
Comparison 
Options 
parameters 
in 
Comparison 
Options 

If selected, the Comparison Options parameters in the 
Comparison Options category of the Rendering Set 
Manager are available to the user enabling the user to 
change the options used when comparing documents. 

Selected 

Show 
Deleted Text 
parameters 
in Redline 
Rendering 

If selected, the Deleted Text parameters in the 
Redline Rendering category of the Rendering Set 
Manager are available to the user enabling the user to 
change how deleted text is displayed in the Redline 
document. 

Selected 
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Parameter Description Default 
Show Font 
Changes 
parameters 
in Redline 
Rendering 

If selected, the Font Changes parameters in the 
Redline Rendering category of the Rendering Set 
Manager are available to the user enabling the user to 
change how font changes are displayed in the Redline 
document. 

Selected 

Show 
General 
Options and 
Change 
Indicator 
Options 
parameters 
in Redline 
Options 

If selected, the General Options and Change Indicator 
Options parameters in the Redline Options category 
of the Rendering Set Manager are available to the user 
enabling the user to change how the Redline 
document is displayed and what information is 
included with the Redline document. 

Selected 

Show 
Inserted Text 
parameters 
in Redline 
Rendering 

If selected, the Inserted Text parameters in the 
Redline Rendering category of the Rendering Set 
Manager are available to the user enabling the user to 
change how inserted text appears in the Redline 
document. 

Selected 

Show Moved 
Text 
parameters 
in Redline 
Rendering 

If selected, the Moved Text parameters in the Redline 
Rendering category of the Rendering Set Manager 
are available to the user enabling the user to change 
how moved text is displayed in the Redline document. 

Selected 

Show 
Readability 
parameters 
in Redline 
Options 

If selected, the Readability parameters in the Redline 
Options category of the Rendering Set Manager are 
available to the user enabling the user to change 
readability options in the Redline document. 

Selected 

Show Style 
Changed 
Text 
parameters 
in Redline 
Rendering 

If selected, the Style Changed Text parameters in the 
Redline Rendering category of the Rendering Set 
Manager are available to the user enabling the user to 
determine how changes to styles are displayed in the 
Redline document. 

Selected 

Show Table 
Changes 
parameters 
in Redline 
Rendering 

If selected, the Table Changes parameters in the 
Redline Rendering category of the Rendering Set 
Manager are available to the user enabling the user to 
set the options for how changes to table cells appear 
in the Redline document. 

Selected 
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General>Administration 
The General>Administration parameters enable you to specify how Workshare 
functions in specific situations. 

 
The General > Administration parameters are described in the following table: 

Parameter Description Default 
Allow users 
to override 
option values 

Administrator Mode only. 
If selected, users can override the values for 
parameters in the Workshare Configuration Manager 
unless individual parameters have been locked. 

Selected 

Backup and 
migrate the 
configuration 
for the 
Current 
Users 

If selected, when you are upgrading from an earlier 
version of Workshare all existing user settings and 
options are transferred to the Workshare 8 installation. 

Selected 

Backup and 
migrate the 
default 
configuration 
for All Users 

Administrator Mode only. 
If selected, when you are upgrading from an earlier 
version of Workshare all existing public settings and 
options are transferred to the Workshare 8 installation. 

Not 
selected 



 

57 

Workshare 9 Configuration Options 

Parameter Description Default 
Cache Word If selected, an instance of Microsoft Word is kept in 

memory when Workshare is in use. This can save time 
when performing certain operations. If not selected, an 
instance of Microsoft Word is started and stopped on 
demand. 

Note: When Microsoft Word starts up invisibly 
(when Cache Word is selected), it does not initialize 
its add-ins. If the user then does something to make 
the instance of Microsoft Word visible (for example, 
initiates editing a document) then the user will be 
working with no add-ins initialized. 

Not 
selected 

Enable 
Customer 
Experience 
Reporting 

Administrator Mode only. 
If selected, Workshare gathers anonymous usage 
statistics and environment information used towards 
product evolvement and improvement. 

Selected 

Hide link to 
launch the 
Workshare 
Configuration 
Manager in 
Administrator 
mode 

Administrator Mode only. 
If selected, there will be no link to Launch 
Administrator Mode in the User mode of the 
Workshare Configuration Manager. 

Not 
selected 
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General>User Interface 
The General >User Interface parameters enable you to customize the Workshare user 
interface and set what options will be available in the Workshare Panel and Workshare 
Ribbon/menu. 

 
The General > User Interface parameters are described in the following table: 

Parameter Description Default 
Enable 
Combine 
PDF 

If selected, the Combine PDF option is enabled in the 
Workshare tab.  

Selected 

Enable 
Compare 

If selected, the Compare option is enabled in the 
Workshare tab.  

Selected 

Enable 
Content Risk 

If selected, the Content Risk option is enabled in the 
Workshare tab.  

Selected 

Enable 
Convert to 
PDF 

If selected, the Convert to PDF option is enabled in 
the Workshare tab.  

Selected 

Hide options 
user cannot 
change 

If selected, the parameters that the administrator has 
locked so that users cannot change are hidden from 
the user in User Mode. 

Not 
selected 
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Integrations>General 
The Integrations > General category is where you select the default document 
provider with which Workshare integrates as well as set parameters general to all DMS 
integrations. 

 
In the top section of the right pane, you can see the document providers with which 
Workshare integrates. Local File Store is always available and Workshare 
SharePoint Connector, iManage, OpenText, NetDocuments and Worldox are 
available if you have the relevant Workshare integration installed and your Workshare 
license includes the relevant integration. 

You specify the default document source by clicking the Set as Default button to the 
right of the required document provider. 
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The Integrations > General parameters are described in the following table: 

Parameter Description Default 
Allow Redline save 
file format to be 
changed 

If selected, the file format can be changed 
when saving the Redline document. 

Selected 

Allow Redline to be 
attached or related to 
the modified 
document 

If selected and when using Hummingbird, the 
Redline document can be saved as an 
attachment to the modified document. 
When using iManage, the Redline document 
can be saved as a related document to the 
modified document. 

Selected 

Allow Redline to be 
attached or related to 
the original document 

If selected and when using Hummingbird, the 
Redline document can be saved as an 
attachment to the original document. 
When using iManage, the Redline document 
can be saved as a related document to the 
original document. 

Selected 

Allow Redline to be 
saved as a new 
document 

If selected, the Redline document can be 
saved as a new document. 

Selected 

Allow Redline to be 
versioned to the 
modified document 
(iManage and 
OpenText only) 

If selected and when using OpenText or 
iManage, the Redline document can be 
versioned to the modified document. 

Not 
selected 

Allow Redline to be 
versioned to the 
original document 
(iManage and 
OpenText only) 

If selected and when using OpenText or 
iManage, the Redline document can be 
versioned to the original document. 

Not 
selected 

Append document IDs 
to the Redline file 
name 

If selected, the document ID or number is 
used as the default name for a Redline 
document when it is saved. 

Not 
selected 
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Parameter Description Default 
Default Redline file 
name 

The name added to the Redline document 
when it is saved. 
When using any of the following functionality, 
the setting specified here will be added to the 
default Redline name. For example: [Default 
Redline file name]_[name of original 
document]-[name of modified document]. 
• Word -> Open in Word 
• Word -> Open in Word with Track 

Changes 
• Save As -> Comparison Document 
• Save As -> Word Document with Track 

Changes 
• Email -> Attach as Word Document with 

Track Changes 
• Email -> Attach as PDF 
• Email -> Attach as PDF (only pages with 

changes) 
• Email -> More Email Options 

 

Display document 
selection dialog when 
using Send to 
Application 
(NetDocuments only) 

If selected, Workshare’s Compare 
Documents dialog is displayed when using 
Send to Application. This enables the user to 
further define their comparison – they can 
switch original and modified, add further 
documents to compare, change the rendering 
set and use the Fast comparison mode. 

Selected 

Enable Redline 
extended save file 
formats 

If selected, the user can choose a file format 
that is support by Microsoft Word when 
saving Redline documents. 

Not 
selected 

Include document 
descriptions in the 
Redline file name 

If selected, the document description is 
included in the name for a Redline document 
when it is saved. 

Selected 

Include document 
locations in the 
Redline file name 

If selected, the document location is included 
in the name for a Redline document when it 
is saved. 

Not 
selected 

Set default format 
when saving Redline 

The default format for the Redline document 
when saving a Redline (WDF, RTF, DOC, 
DOCX, TEXT or PDF). 

Portable 
Document 
Format 
(.pdf) 
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Integrations>iManage 
The Integrations > iManage category is where you can add details of your iManage 
server as well as set specific parameters determining how Workshare interacts with 
iManage. 

In User Mode, the Integrations > iManage category is available for iManage license 
holders only.  

Note: In order for this category to be available, you must ensure your Workshare 
license includes the iManage integration. 

In Administrator Mode, the Integrations > iManage category is always available.  

 
The list of configured iManage servers is displayed in the Servers section of the right 
pane. You can add an iManage server as required. 

To add an iManage server: 

1. In the Integrations > iManage category, click Add. An entry is added to the list 
of iManage servers in the Servers section. 
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2. In the Server Name field, enter the name of your iManage server. 

3. In the UserID and Password fields, enter the user login details that enable login 
to the specified server.If you connect to your iManage server using your 
Windows account, select the TrustedLogin checkbox only. 

4. Select the AutoLogin checkbox to automatically connect to the server and 
authenticate the user at startup. If you do not select this checkbox, the server 
can be registered but will not be authenticated at startup. This may be useful in a 
multi-server environment when you want to save the overhead of authenticating 
all the servers at startup. 

Note: If a document ID is passed to a Workshare product for a document on a 
server for which it has details (a registered server) but to which it is not 
connected, then the Workshare product will automatically connect to that 
referenced server.  

5. Click Test to confirm connection to the specified server. 

To delete a server from the list, click Remove to the right of the server details. 

The Integrations > iManage parameters are described in the following table: 

Parameter Description Default 
Alternate 
Class Name 

If the Use Alternate Class Name parameter is 
selected, the class name to use. This class MUST 
exist on your iManage server 

COMPARE 

Alternate 
Conversion 
Class Name 

If the Use Alternate Class Name for Conversions 
parameter is selected, the class name to use when 
converting to PDF. This class MUST exist on your 
iManage server 

DOC 

Document 
Profile name 

When automatically profiling documents, the 
document profile name to use. 

New 
Profile 

Prevent 
users from 
adding or 
removing 
server 

If selected, users cannot add or delete server details 
in User mode. 

Not 
selected 

Use Alternate 
Class Name 

If selected, the class name (specified in the Alternate 
Class Name parameter) is used in the profiling when 
saving Redline documents (comparisons). 

Not 
selected 

Use Alternate 
Class Name 
for 
Conversion 

If selected, the class name (specified in the Alternate 
Conversion Class Name parameter) is used in the 
profiling when converting documents to PDF. 

Not 
selected 
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Parameter Description Default 
Use 
AutoProfiling 
for iManage 

If selected, automatic profiling is performed when 
adding documents to the iManage database. 

Not 
selected 

Integrations>Microsoft SharePoint 
The Integrations > Microsoft SharePoint category is where you can add SharePoint 
sites configured on your SharePoint server details as well as set specific parameters 
determining how Workshare interacts with Microsoft SharePoint. 

In User Mode, the Integrations > Microsoft SharePoint category is available for 
SharePoint license holders only.  

Note: In order for this category to be available, you must ensure your Workshare 
license includes the SharePoint integration. 

In Administrator Mode, the Integrations > Microsoft SharePoint category is always 
available. 

 
The list of specified SharePoint sites is displayed in the Servers section of the right 
pane. You can add new SharePoint sites configured on your SharePoint server as 
required. 
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To add a SharePoint site: 

1. In the Integrations > Microsoft SharePoint category, click Add. An entry is 
added to the list of SharePoint sites in the Servers section. 

 
2. In the text box, enter the complete URL for the SharePoint site location. 

3. From the Metadata Cleaning Policy dropdown list, select how the site is to be 
considered for policy application purposes. If you select Internal Cleaning 
Policy, documents at the specified SharePoint site will be treated similarly to 
documents emailed internally. If you select External Cleaning Policy, 
documents at the specified SharePoint site will be treated similarly to documents 
emailed externally. 

4. Click Test to confirm connection to the specified site. 

To delete a site from the list, click Remove to the right of the site details. 

The Integrations > Microsoft SharePoint parameters are described in the following 
table:  

Parameter Description Default 
Default View The default view selected in the list of Use Views.  

LDAP lookup 
server 

The LDAP server:port (for example, NY1LDAP1:390). 
When users are adding members to a SharePoint 
workspace during the Send for Review process, they 
are able to utilize Microsoft Outlook’s address book to 
choose members. Workshare will read Outlook’s 
Exchange configuration and attempt to contact the 
LDAP server. In some circumstances, it may be 
necessary to override the automatic resolution, 
namely: 
• The LDAP server port on Microsoft Exchange 

Server is on a different port (usually 389). 
• Lotus Notes is being used as the email client. 
• You wish to utilize another LDAP compatible 

directory service. 
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Parameter Description Default 
Profile New 
Documents 

If selected, when a document is saved into SharePoint, 
a form is displayed to collect document metadata. 

Note: To enable this profiling feature, the 
SharePoint site must have custom content types set 
up. 

Not 
selected 

Use Views If selected, a dropdown list of the views available in a 
SharePoint document library is displayed in the top 
right of the SharePoint browser window. This acts as a 
filter for the files displayed by the browser. 

Not 
selected 

Registry Configuration 
This section describes configuration of Workshare that is done by making changes in 
the Registry. 

Important: If you use Registry Editor incorrectly, you may cause serious problems 
that may require you to reinstall your operating system. Only system administrators 
should attempt to make changes in the Registry.  

Convert Hyperlinks 
When converting documents to PDF files, the Workshare PDF driver does not by 
default convert hyperlinks. Some PDF reader will convert hyperlinks within a PDF. If 
you want the Workshare PDF driver to convert hyperlinks when creating the PDF, you 
need to create the Registry value PDFFileNameOptionsEx in the Registry key 
SOFTWARE\Workshare\Options\8.00\Internal\PDF with a string value of 0x00140091. 
Use HKEY_LOCAL_MACHINE to set an option machine-wide and 
HKEY_CURRENT_USER to set an option for a user. Note that enabling this feature will 
impact performance and will slow down the PDF conversion process. If you want to turn 
the Convert Hyperlinks feature off, you should either remove this Registry value or 
change the Registry value to 0x00040091. 



 

67 

Workshare 9 Configuration Options 

Small Text Removal 
When Workshare is configured to clean/delete small text (smaller than 5 points), it will 
check content for half sizes as well as full sizes (4.5, 4, 3.5, 3, 2.5, 2, 1.5, 1, 0.5) and 
this may slow down the cleaning process. If you want Workshare to just clean full point 
sizes (4, 3, 2, 1), you need to create the Registry value HalfPointSmallTextSupport in 
the Registry key SOFTWARE\Workshare\Options\8.00\Protect\ProtectAdmin with a 
string value of true. Use HKEY_LOCAL_MACHINE to set an option machine-wide and 
HKEY_CURRENT_USER to set an option for a user. 
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